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1. Introduction 
 
The purpose of this document serves as a basic self-tutorial guide for users to 
familiarise themselves with the Elixir Repertoire Report Designer. These step-by-step 
exercises will assist users in understanding the following processes: 
 
1. Report template creation 
2. Mapping a data source to the report template 
3. Adding sections to a report template 
4. Adding page layouts to a report template 
5. Add a cover page to the report template 
6. Sorting and Grouping of data 
7. Basic scripting and aggregate functions 
8. Adding a 3D bar chart 
9. Implementing watermark to the main report 
10. Designing a data cube  
 

2. Elixir Repertoire Report Designer Environment  
 
Below is a brief overview of the work area that users will be working with throughout 
these exercises: 
 
 
 
 

 
 
 
 

Navigation View 

Property View 

Tab
s 

Section Viewer 

Tool Bar 
Workspace 

Repository 
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3. Orientation and Shortcut Commands 
 
General Shortcuts: 
 
Actions Shortcut Commands 
Copy Ctl + “C” 
Paste  Ctl + “V” 
Undo Ctl + “Z” 
 
 
For Repository: 
 
Actions Shortcut Commands 
Copy a File Highlight, Ctrl+Move mouse 
Move a File Highlight, Move mouse 
Copy Repository URL Right Click, select “Copy URL” 
Invoke Menus on Folder Right Click on Folder 
Add element to Report Design Area Click on Report Element, Click on empty 

Canvas Area 
Add/Remove ruler Click on Ruler Area ( Horizontal/Vertical) 
 
 
Report Layout: 
 
How to select more than 1 element 

1. Click and Drag Select elements or 
2. Select 1 report element and Ctl-Select another 
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4. Installing Elixir Repertoire Designer 

4.1. Installation Requirements 
 
Elixir Repertoire supports any Java SE version 5.0 Runtime Environment (JRE) 
update 12 (or later) compliant platforms such as the following: 
 
• Windows 
• Solaris (including 10) 
• AIX 
• Linux 
• Macintosh OS X (10.2 or higher) 
 

4.2. Software Requirements 
 
Elixir Repertoire requires the following software to run. Please make sure you install 
the software prior to installing Elixir Repertoire: 
 
·  The software requires a Java SE version 5.0 Runtime Environment (JRE) update 

12 or later. If you do not have Java pre-installed, please download and install it 
from: http://java.sun.com/javase/downloads/index.jsp or from your preferred 
vendor. 

·  Adobe Acrobat PDF viewer plug-in on the client web-browser 
 

4.3. Hardware Requirements 
 
Elixir software is able to run on a usual entry level system available in the market. As 
long as the operating system and the Java runtime are able to operate smoothly, Elixir 
software itself only requires an incremental amount of RAM.  
 
You may refer to the “System requirements for the Java Runtime Environment 5.0” at 
http://www.java.com/en/download/help/5000011000.xml. 
 
For Elixir Repertoire Designer, a recommended minimum RAM configuration would 
be 256MB, and for more advanced usage, 512MB is recommended. 
 
In addition, a total of 150MB disk space is recommended for the following: 
• 50 MB for Elixir Repertoire Designer application files, documentations and samples 
• Up to 80 MB for the Java runtime (depending on the version) 
• 20 MB reserved space for other 3rd party add-on software like database drivers. 
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4.4. Before Installation 
 
Ensure you have Administrator privileges. If you are installing Elixir Repertoire on a 
computer running any of the supported operating systems (see Installation 
Requirements above), you must have Administrator privileges. The installation 
process creates registry entries and may update some system files that require 
Administrator rights. 
 

4.5. Ensure Java is Pre-Installed 
 
The software requires a Java SE version 5.0 Runtime Environment (JRE) update 12 or 
later. If you do not have Java pre-installed, please download and install it from 
http://java.sun.com/javase/downloads/index.jsp or from your preferred vendor.  
 
To find out if your system has the correct version of Java installed, go to the 
command prompt and key in the following: 
 
java -version  
 
The system will return the following as an example: 
 

 
 

4.6. Installing Elixir Repertoire 
 
·  For any Java enabled platforms, please unzip Repertoire7.x.x.zip to a specific 

installation path. Deploy the database drivers and license keys accordingly (see 
“Installing Database Drivers and Additional Class Files” and “Deploying the 
License Key”). Create a start up shell script (.sh file) as shown in “Running Elixir 
Repertoire Designer in Debug Mode”. 

 
·  For Windows Platform, please click and run Elixir Repertoire Installer 7.x.x.exe 

to begin guided installation. 
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An installation path dialog box appears for you to choose your desired installation 
location. Default installation directory is C:\Program Files\Elixir Repertoire 
 
Do take note that if you are installing an upgrade of Elixir Repertoire, the installation 
wizard will prompt you with a warning, stating that the new version will be installed 
at the default location, thus overwriting your old version of Elixir Repertoire. If you 
wish to keep the previous version, do change the installation path to prevent 
overwriting the old version. 
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You will then be prompted to select the various components for installation. Leave the 
selection as is and click “Next” to continue. 
 

 
 
Change the name of the start menu folder containing the Elixir Repertoire shortcuts 
and leave it as is and click “Next” to continue with the installation. 
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Click “Next” to proceed with the installation. Depending on the speed, the installation 
of Elixir Repertoire will be completed in a few minutes. 
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4.7. Installing Database Drivers and Additional Cla ss Files 
 
The installation of database drivers and additional 
Java class files can be installed in the /ext directory of 
the Repertoire installation.  
 
Database drivers must support JDBC connectivity and 
be packaged as jar files. An example of a typical /ext 
directory may look like the following example: 
 
 
 

 
    

 

4.8. Deploying the License Key 
 
Copy the license key, e.g. ElixirRepertoire7-Designer-license.txt or ElixirRepertoire7-
Designer-license.zip to $USER_HOME directory, eg. C:\Documents and 
Settings\User before running Elixir Repertoire Designer. 
 
If the application starts up with a message that the 
license key cannot be found, access the “Global 
Properties” to manually install the license key. 
 
At the “Global Properties” dialog box, 
access the first tab, “License” and click 
on the “…” button to select the location 
of your license key. Select the license 
key and click “Open”. The “Global 
Properties” dialog box will now display 
the licensing details.  
 
Click on “Install License” to deploy the 
license key followed by “Ok” when 
done. 
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4.9. Starting Elixir Repertoire Designer 
 
Once the key is deployed, run the 
software from the start menu by 
accessing the Elixir Repertoire 
folder followed by the Elixir 
Repertoire icon.  
 
Alternatively, the Elixir Repertoire 
executable can also be accessed from 
the /bin directory of the Repertoire 
installation path. 
 
 

 

4.10. Running Elixir Repertoire Designer in Debug M ode 
 

 
 
Running Elixir Repertoire Designer in debug mode allows users to monitor and track 
any errors arising from the design of their report templates and data sources. To run in 
debug mode, open a text editor and input the following as a single line, modifying the 
text in bold according to your own environment: 
 
"C:\Program_Files\java\jre1.6.0_02\bin\java.exe" -mx512m -classpath 
.\Repertoire-Launcher.jar com.elixirtech.repertoire.Launcher   
 
Save the text as a batch file (.bat) in the /bin directory of the Repertoire Designer 
installation and execute this .bat to run in debug mode.  
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5. Preparing the Exercise Environment  
 
This exercise is part of a series of self-help practices and 
tutorials to get users familiarised with the Repertoire 
Designer. Each exercise is categorised based on specific 
features. To get started, create an “ER_Exercises” folder 
and a “Report-Designer” subfolder if you have not done 
so from pervious exercises. Unzip the “Ex_WYSIWYG” 
folder into “ER_Exercises/Report-Designer” so that the 
directory structure would be “ER_Exercises/Report-
Designer/ Ex_WYSIWYG” as shown in the example.   
 
In the Repertoire Designer environment, the 
“ER_Exercise” folder needs to be added to the 
repository to access the files. To begin, click on 
the “Add Filesystem” button. 
 
Highlight the option “Local Filesystem” and 
click on “Next”. Go to “Directory” and click on 
the “…” button. Select the “ER_Exercises” 
directory and click “Open”. In the “Name” field, 
input “ER_Exercises”. The pop dialog should 
look like the example below. Click “Finish” to 
continue. 
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The “ER_Exercises” will appear in the repository as 
shown in the example. 
 
If the “ER_Exercises” directory and “Report-
Designer” sub directory were created from a 
previous exercise, unzip the “Ex_WYSIWYG” 
exercise directory accordingly. Ensure that the 
folder structure appears accordingly in the example 
shown. 
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6. Part 1: Employee Summary Report 
 
The Employee Summary Report consists of the following sections: 
 
- Cover Page 
- Summary Table  
- Employee details  
 

 
 

Cover Page 

 
 

Summary Table 

 
 

3D Chart 
 

 
 

Employee Details 

 
 
The creation of this report template will be covered in this step by step guide. 
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6.1. Data Source 
 
Every report template requires a data source which stores data or information that has 
been retrieved from a database or flat files (csv, excel) to be presented in the report 
template.  
 
Data sources can be added to a report template either through the Report Wizard 
during creation or in the “Report” tab of the template’s workspace. Each report 
template can have more than one data source. 
 

 
 
To manually add a data source to the template, go to the “Report” tab, look for the 
template structure on the left of the workspace and right click on the DataSources 
node to add a data source. Follow the steps in the wizard to finish the process. 
 
 

6.2. Employee Details 
 
We will first create the employee details section of the report. Employee details that 
would be presented are their employee ID, first name, last name as well as their 
salary. This section will then be designed to present these details based on the 
following breakdown: 
 

- Employees grouped by their management role 
- Employees grouped by department ID 

- Employees grouped by education levels in each department 
 
To begin, create a new blank report template. Right click on the “workspace” folder, 
select “Add” followed by “report template”. Follow the wizard instructions and select 
“black report” as the template. In the “Report” tab, look for the “DataSources” node 
in the template structure and add the “employees” data source (right click, “Add 
DataSource”). Name the data source “employees” in the “Enter DataSource 
Parameters” section.  
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6.3. Adding a Page Title Header 
 

 
 
1. Add an image element to the “Page Header” of the template workspace by first 
clicking on the image icon on the tool bar then on the “Page Header”.  
2. Ensure that the image URL reflects the correct image file located in the “resources” 
folder under the image properties. 
 
 

6.4. Populating the Report 
     
1. Go to the “Layout” tab. Notice that the report template has been divided into five 
bands: 
 
- Page Header 
- Section Header 
- Detail 
- Section Footer 
- Page Footer 
 
2. Go to the “Data” tab on the right hand side (navigational view) of the workspace.  
3. Double click on “employees” data source icon to expand the data columns. Each 
data column in the data source contains a specific set of data.  
4. Select by holding “Ctrl” and clicking the “employee_id”, “first_name”, 
“last_name” and “salary” columns. Hold on to “Ctrl” and drag these fields onto the 
“Detail” band. Hold the “Alt” key and click to select each field in the horizontal box. 
Adjust their alignment respectively, by clicking on the “Position” section in the 
property view to toggle the “Text Align”. 
5. A field layout wizard will appear. Select the “Horizontal” tab and check “Use 
Vertical Box”.  
6. Click “Finish” when done.  
 
If the report template were to be rendered now you would see a long list of names and 
their respective details with no form of differentiation or grouping.    
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6.5. Sorting and Grouping 
 

 
 
The next step would be to sort the employee list. 
  
1. Go to the “Report” tab, look for the “Sections” node and right click on the current 
section (Section1) and select “Edit Section”.  
2. Click on the “Group and Sort” tab and click on the “Add” icon (see above).  
3. From the drop down lists, select “management_role” for “Name”, “Ascending” for 
“Sort Order” and “Each Value” for “Group On”.  
 
4. Repeat this step two more times 
for: 
i) Name: “education_level” Sort 
Order: “Ascending”, Group On: 
“Each Value”.  
ii) Name: “salary”, Sort Order: 
“Ascending”, Group On: “None”. 
 
The employee details retrieved from 
the data source are now sorted and 
grouped based on the following 
order: 
 
- Management Role (sorted ascending and grouped on each value) 
- Education Level (sorted ascending and grouped on each value) 
- Salary (sorted ascending order) 
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6.6. Adding Page Break and Rendering a Preview 
 
A page break will be implemented so that every “management_role” section will start 
on a new page. To proceed, click on “Group Header: management_role” in the layout 
tab. Go to the “Shapes” tab in the navigational view and select the “Group Header: 
management_role” header. Go to the property view and set “Force New Page” value 
to “Before”.  
 

 
 
 
Render the report template to see the current progress of this 
tutorial.  
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Select “Glint” to render a preview image of the report template. Click “Finish” when 
done. 
 
If no changes to the rendering preferences are made, users have 
the option of using the “Repeat Render” option which renders 
the current report template based on the last render settings.  
 
 

6.7. Labelling Data Fields 
 

 
 
To further differentiate the groupings, two headers will be implemented; one for 
management roles and the other for education levels. Go to the “Data” tab in the 
navigational view and drag the “management_role” data column onto the “Group 
Header: management_role” band and “education_level” data column onto the “Group 
Header: education_role” band. 
 
For both data fields, the data displayed is retrieved from the data source. However, 
more details need to be added to make it a meaningful label.  



___________________________________________________________________________________ 
Copyright © 2008 Elixir Technology Pte Ltd  Page 20 of 31 

1. Right click on the “management_role” 
data field in the “Group Header: 
management_role”, select “properties” 
from the pop-up menu and go to the 
“Field” tab.  
2. Select “Script” from the “Field Type” 
drop down menu.  
3. The data column “management_role” 
label remains in the input box.  
 
 
4. Add the following text before the label: 
 

       
The data label will now print “Group By:” followed by the management roles in the 
data source when the report template is rendered. Go to the “Property View” and add 
a background colour for both data labels. 
 
Repeat the above mentioned steps for “education_level” in the “Group Header: 
education_role” band with the following and try rendering the template when done: 
 

 
 
 

6.8. Implement Aggregation Functions 
 
The next step for this report is to implement aggregation functions which will give an 
indication as to the headcount in each education level grouping as well as the overall 
headcount per management role. 
 
1. Click on the “Detail” band and go to 
the “Shapes” tab in the navigational 
view.  
2. Right click on the “Fields” horizontal 
box and select “Copy” from the pop up 
menu.  
3. Right click on “Group Footer: 
education_level” and select “Paste” from 
the pop menu.  
4. The vertical box containing the data 
fields have been duplicated and pasted in “Group Footer: education_level”. 
 

"Group By: "+management_role 

"Group By: "+education_level 
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5. To be able to select a single data field, hold the “Alt” key and left click on the first 
data field in the horizontal table.  
6. Right click on the first data field and select “Properties”.  
7. Go to the “Field” tab and select “Operation” from the “Field Type”. A new set of 
options will be displayed below the column list.  
8. Select “Count” from the drop down menu and check the “Over Group” radio 
button. Click “Ok” when done. 
 
9. Proceed to the property view and 
expand the “Border Lines” section.  
10. Uncheck the “Left” and “Right” 
options.  
11. Expand the “Border” section and 
select “Solid” from the “Style” drop 
down menu.  
12. Expand the “Position” section and 
select “Left” from the “Text Align” drop 
down menu. 
 
13. Now hold “Alt” and click on the 
second (first_name) and third 
(last_name) data fields in “Group 
Footer: education_level”, go to the 
property view and uncheck the “Visible” options. These fields are now hidden in the 
footer when the report template is rendered. 
14. Repeat the steps 9 to 12 for the fourth data field, “salary”, to implement a “Sum” 
function “Over Group”. 
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15. When done, copy the horizontal box from “Group Footer: education_level” 
(Ctrl+”C”) and paste it in the “Section Footer” (Ctrl+”V”). The data fields in the 
“Section Footer” will return a grand total for the overall number of employees and 
sum of salaries paid. 
 

6.9. Adding Page Count and Time Stamp 
 
1. Expand the “Page Footer” to add two data fields from the tool bar; one on the far 
left and the other on the far right.  
2. Right click on the data field on the far left, go to “Field” tab, select “Script” from 
the “Field Type” drop down menu and input the following: 
 

 
 
3. Go to the “Format” tab, select “Date/Time” from the “Format Type” and enter the 
following under the “Custom Pattern” field: 
 

 
 
4. Right click on the data field on the far right, go to “Field” tab, select “Script” from 
the “Field Type” drop down menu and input the following: 
 

 
 
Render the report template to observe that a date and timestamp has now been added 
to the bottom left of the page while a page count has been added to the bottom right of 
the page. 
 

"${#} of ${##}" 

dd-MMM-yyyy hh:mm:ss a 

new java.util.Date() 
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6.10. Changing the Employee ID to Barcode 
 
1. Go back to the “Detail” band and under the “Shapes” tab, expand the “Fields” 
horizontal box.  
2. Delete the first data field (employee_id) and replace it with a barcode from the tool 
bar by clicking on the barcode icon on the tool bar and clicking on the field in the 
horizontal box.  
 

 
 
3. Hold “Alt” and click on the barcode data field to select it. Right click to access the 
barcode properties and access the “Data” tab.  
4. Select “employee_id” from the column list.  
5. Go to the “Barcode” tab and check “Show Text”.  
6. Click “Ok” when done. 
7. Adjust the height of the horizontal box accordingly by expanding the details band 
and the horizontal box until the numbers below the barcode are visible. 
8. In the property view, go to the background colour property, click on “…” and select 
the “Transparency” tab to adjust the alpha slider to “50%”.  
9. Render the report template to observe the newly added barcode element. 
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6.11. Adding a 3D Chart 
 
1. Add a chart by clicking on the chart icon on the tool bar followed by clicking on 
the “Section Header” of the workspace.  

 
2. Check “Over all” in the Chart Wizard and select “Next”. 
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3. Select “3D Charts” followed by “3D Column” and click “Next”. 

 
 
4. Select “education_level” in the “X” tab. 
5. Select “salary” in the “Y” tab. 
6. Select “management_role” in the “Z” tab. 
7. Click “Finish” when done. 
8. Render the report template. The 3D chart should precede the employee details. 
 

6.12. Adding a Watermark 
 
A “Confidential” watermark will now be added to the Employee Details section of the 
report. 
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1. Go to the “Report” tab and right click on the “Sections” node. 
2. Select “Add Section” from the pop up menu. Name this section “Confidential” 
3. Select “<None>” for the data source. 
4. Select “Default” from the “Page Setup” drop down menu. 
5. Click “Finish” when done. 
6. Go to the “Layout” tab in the workspace. 
 
7. Select “Confidential” from the 
“Section” drop down menu. 
8. Add the “Confidential” image to 
the “Section Header” of the template. 
Go to the “Image” section in the 
properties view and collapse it. Set 
the image “Size Mode” to “Stretch” and its “Vertical Align” to “Centre” in the 
“Property View”. 
9. Add a rectangle shape element over the “Confidential” image. Remove the borders 
from the shape via the “Property View”. This adds a transparency layer mask to the 
image file. 
10. Go to the background colour wizard of the rectangle and select the 
“Transparency” tab in “Property View”. Set the alpha value by moving the slider to 
“80%”. 
 

 
 
11. Go to the “Report” tab and select the section containing “Employee Details” 
(Section1). Right click to edit and under the “Watermark” tab, select “Confidential” 
from the “Section” drop down menu. 
12. Render the report template to ensure that the watermark can be seen. Adjust the 
alpha values for the watermark or group header accordingly if it doesn’t display based 
on requirements. 
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7. Part 2: Adding Summary Table 
 
The summary table will present the total number of staff in the various management 
levels according to their education qualifications. 
 

7.1. Add Landscape Page Setup 
 

 
 
1. Go to the “Report” tab and right click on the “Page Setup” node. 
2. Select “Add Page Setup” from the pop up menu and name it “Landscape”. 
3. Select the “Landscape” option in the “Page Setup” wizard. 
4. Click “Finish” when done. 
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7.2. Create New Section 
 
1. Go to the “Report” tab and right click on the “Sections” node. 
2. Select “Add Section” from the pop up menu. Name this section “Summary Table” 
3. Select the data source “employees” from the “Data Source” drop down menu in the 
“Section Wizard”. 
4. Select “Landscape” from the “Page Setup” drop down menu. 
5. Click “Finish” when done. 
 

 
 

7.3. Add Cube Summary Table 
 
1. Go to the “Layout” tab of the workspace. 
2. Select “Summary Table” from the “Section” drop down menu. 
3. Add a data cube element to the “Section Header”. 
 

 
 
4. Under “Properties”, select the data source and click the “Over All” option. 
5. Click on “Open Cube Wizard”. 
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6. Click “Next” to the “Cube Axes” and select “education_level” as the column 
dimension and “management_role” as the row dimension. 
 
7. Click “Next” to the “Cube Measures” and 
select “department_id” and “Count” function. 
8. Click “Finish” and “Ok” when done. 
9. Add borders to the cube summary table by 
selecting the cube elements in the “Shapes” tab 
and setting the borders to “solid” in the property 
view. 
10. Adjust the font size accordingly for the cube 
labels, rows and columns via the property view.  
11. Add a “Summary Table” label above the cube table. 
 
We will now add a condition to the cube table whereby the background colour will 
change when the number of education level holders (Count(department_id)) is more 
than 200. 
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12. Go to the “Shapes” tab and right click the “Count(department_id)” cube measure.  
13. Select “Properties” followed by the “Presentation” tab. 
14. Click on “Add” for additional render options. Choose a background colour and 
select “More Than” as the “When” condition and input “200” in the text field next to 
it.   
 

 
 
15. Go to the “Report” tab, and add a new row to the “Render Sequence” table. Select 
“Summary Table” and its respective data source. Click on the “up” arrow button to 
move the “Summary Table” row to the top. Upon rendering the report, the “Summary 
Table” will appear before the report details. 
 

8. Part 3: Adding Cover Page 
 
A cover page will be added to the report. 
 

 
 
1. Go to the “Report” tab and right click on the “Sections” node. 
2. Select “Add Section” from the pop up menu. Name this section “Cover Page” 
3. Select “<None>” for the data source. 
4. Select “Default” from the “Page Setup” drop down menu. 
5. Click “Finish” when done. 
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6. Go to the “Layout” tab in the workspace. 
7. Select “Cover Page” from the “Section” drop down menu. 
8. Add a label to the “Section Header” and input the following title: 
 
 
 
 
 
9. Go to the “Report” tab, and add a new row to the “Render Sequence” table. Select 
“Cover Page”. Click on the “up” arrow button to move the “Summary Table” row to 
the top. The “Cover Page” will now be rendered first, followed by “Summary Table” 
then the report details. 
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